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1. Introduction

1.1 Welcome to NiceLabel Control Center

NiceLabel Control Center is the enterprise solution for client/server based label printing and
centralized systems management. All labeling software licensing is included in one package.

NiceLabel Control Center environment consists of the following elements:

e NicelLabel PowerForms Desktop installed on workstations, where users are
designing and printing the labels;

e NiceLabel Enterprise Print Manager (EPM) installed on the server, offering
following functionality:

o Flexible licensing of all NiceLabel workstations.

o NiceLabel workstations logging and configuration stored centrally on the
server.

o Monitoring the status of all printers.

o Managing print jobs (monitor status, restart, move jobs to other printer).
o Proactive alerting in case of possible problems.

o Concurrent access to management console using a standard Web browser.

o Authentication feature enables administrators to manage the printing
environment while users can only monitor it.

o Revision control system (versioning) and workflow support.

1.2 About this Manual

This User Guide helps you install and integrate the NiceLabel Control Center into your
enterprise IT environment.

The User Guide contains the following sections:
Introduction: Introduces the NiceLabel Control Center software.

NiceLabel Control Center Overview: Learn about the NiceLabel Control Center basics,
modules and understand the architecture.

Installation and Activation: Learn how to install and activate the NiceLabel Control Center
software.

Enterprise Print Manager: Introduces the module for remotely managing printers, print
queues, events and alerts.

NiceLabel Control Center Configuration: Explains the Configuration tool and its settings
for all programs.

NiceLabel Print Queue: Describes the Print Queue and how it can be managed using
NiceLabel Print Queue Manager.

Technical Support: Contacting technical support.
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1.2.1 Software Restrictions

All features explained in this User Guide are available in the NiceLabel Control Center
product. However, some features are not available in NiceLabel PowerForms Desktop and
NiceLabel Automation Enterprise products.

1.2.2 Typographical Conventions

Text that appears in bold refers to menu names, file names like SETUP.EXE and buttons like
the OK button.

Text that appears in italic refers to confirming actions like Read only, locations like Folder or
software window names.

Text enclosed in <Less-Than and Greater-Than signs> refers to keys from the desktop PC
keyboard like <Enter>.

Variables are enclosed in [brackets] like [variable].
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2. NiceLabel Control Center Overview

2.1 Overview

NiceLabel Control Center is an enterprise-level labeling solution with centralized control
over all NiceLabel workstations in a network environment. The NiceLabel Control Center
applies to large environments with many labeling workstations.

Based on their role, users can execute different tasks in the NiceLabel printing environment:

NiceLabel users e Label design and printing

e Web printing

e Document Storage Server

e Remote reprinting

e Print job management using NicePrintQueue
e Local NiceLabel logging

e Changing local settings

NiceLabel operators e Centralized print job management
and administrators .
e Printer group management

e Centralized control over all printers and print queues

e Centralized printing and event logging

e Central logging of executed NiceLabel Automation actions
e Alerting via SMTP mail, NetSend, RSS 2.0 Feed or SMS
e NiceLabel licensing management

e Revision control system

e Workflow support

Note: Net Send type of alerts cannot be used on computers with Windows Vista and above
operating systems, because the Messenger service, needed for this functionality is no
longer available in Windows Vista and above operating systems.

2.2 Architecture

The NiceLabel Control Center product uses a distributed architecture with two main modules.
On workstations, users work with the NiceLabel PowerForms Desktop application for label
design and printing. As a part of NiceLabel PowerForms Desktop, a service called Label
Services is monitoring the local printing process. Printer and job statuses are sent to the
server, where the NiceLabel Enterprise Print Manager (EPM) component is centrally
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controlling the printing process of every NiceLabel workstation. EPM stores all reported
client information into its database.

NiceLabel EPM is a Web based application. You can use a standard Web browser to control it
from your machine or from any other workstation in the network. You can perform Web
printing, reprint past print jobs remotely, access the Document Storage Server, set up and
manage printer groups, view the status of each NiceLabel client, view its event and error logs,
manage the print jobs and create alerts.

NiceLabel EPM can alert you upon arrival of a predefined condition, such as an error, a
warning, or simple confirmation of an executed print job. Several notification options are
available: e-mail (through SNMP), Net Send message, RSS 2.0 Feed or SMS message sent to
your mobile phone.
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3. Installation and Activation

3.1 Overview

NiceLabel Control Center solution consists of several distributed components in your
environment. While the NiceLabel Control Center product is installed on the server, the
NiceLabel PowerForms Desktop product is installed on client workstations. The components
have different requirements and installation and activation procedures.

NiceLabel Control Center installation consists of two parts:

1. Install NiceLabel Enterprise Print Manager (EPM) on the server. Please refer to
CPU: Intel or compatible x86 family processor

Memory: 256 MB or more RAM

o Hard drive: 1 GB of available disk space

o Operating system: One of the 32-bit or 64-bit Windows operating systems: Windows
XP, Windows Server 2003, Windows Server 2003 R2, Windows Vista, Windows
Server 2008, Windows Server 2008 R2, Windows 7, Windows 8, Windows Server
2012

o Display: 1024x768 or higher resolution monitor

2. Installing NiceLabel Control Center topic.

3. Install the NiceLabel PowerForms Desktop product on workstations to enable
barcode label design and printing. Please refer to To install NiceLabel EPM, see the
document NiceLabel EPM Installation Guide available on the NiceLabel DVD.

4. Installing NiceLabel PowerForms Desktop topic.

When you put the NiceLabel DVD in your optical drive, the main menu application will start
automatically. You can browse the directory of the CD, look at the brochures and technical
documentation, and install the NiceLabel software and NiceLabel Printer Drivers.

3.2 System and Software Requirements

3.2.1 NicelLabel Enterprise Print Manager

To install NiceLabel EPM, your equipment needs to fulfill the system requirements.
e CPU: Intel or compatible x86 family processor

e Memory: 512 MB or more RAM

o Hard drive: 1 GB of available disk space
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« Operating system: One of the 32-bit or 64-bit* Windows server operating systems:
Windows Server 2003, Windows Server 2003 R2, Windows Server 2008, Windows
Server 2008 R2, Windows Server 2012

o Microsoft .NET Framework Version 4.0
e ASP.NET AJAX Extension

« 1IS6orlIS7orllS 8 (If you use IIS 7 or 1IS 8, you must install 11S 6 Metabase
Compatibility and 1IS 6 Management Console before you can install the software. See
NiceLabel Knowledge Base article KB168 for details)

o Database Server: Microsoft SQL Server 2005, Microsoft SQL Server 2008, Microsoft
SQL Server 2012 (Express versions supported)

o Display: 1024x768 or higher resolution monitor

3.2.2 NicelLabel PowerForms Desktop workstations

To install and run the program you need at least the following:
e CPU: Intel or compatible x86 family processor

e Memory: 256 MB or more RAM
« Hard drive: 1 GB of available disk space

e Operating system: One of the 32-bit or 64-bit Windows operating systems: Windows
XP, Windows Server 2003, Windows Server 2003 R2, Windows Vista, Windows
Server 2008, Windows Server 2008 R2, Windows 7, Windows 8, Windows Server
2012

o Display: 1024x768 or higher resolution monitor

3.3 Installing NiceLabel Control Center and EPM

To install NiceLabel EPM, see the document NiceLabel EPM Installation Guide available
on the NiceLabel DVD.

L If you use 64-bit OS and want to use data from Microsoft Access database, you must configure the Application
Pool EPWebPrintAppPool to enable 32-bit applications (an option in Advanced settings).
2If you have 11S 7, you must install 11S 6 Metabase Compatibility and 11S 6 Management Console before you can

install the NiceLabel software. See NiceLabel Knowledge Base article KB168 for details.
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3.4 Installing NiceLabel PowerForms Desktop

NiceLabel PowerForms Desktop is the label and form designer which will help you create
label formats and printing applications (forms) for your Web printing users. Typically, you
will install NiceLabel PowerForms Desktop to the design workstations, not to the server.

Note: You must be logged on the computer with administrative rights to be able to perform
the software installation.

To install the NiceLabel PowerForms Desktop, do the following:

1. To ensure a complete installation, close all open applications before installing the
software.

2. Insert the NiceLabel Control Center DVD in your DVD-ROM drive. An installation
window will open automatically.

Note: If the installation wizard does not start automatically, go to the main CD directory of
your NiceLabel Control Center DVD and double-click the START . EXE file.

(@ Nicelabel Control Center l = ‘ ‘&J‘

Nicelab Ia @ Install NiceLabel product
iceLape
@ Install NiceLabel Printer Drivers

@ Explore DVD

NicelLabel
CONTROL CENTER

www.nicelabel.com

-

Figure 1: Main menu in auto-run application on NiceLabel Control Center DVD

3. Click on Install NiceLabel product. A new window will open showing the available
products.
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-

p
@ Nicelabel Control Center =
. A @ NiceLabel Enterprise Print Manager
NicelLabel .
@ NicelLabel PowerForms Desktop

® Back

NicelLabel
CONTROL CENTER

www.nicelabel.com

Figure 2: Selecting NiceLabel PowerForms Desktop for installation

4.

Click on NiceLabel PowerForms Desktop then click Next to begin the installation.
Follow the wizard prompts.

Click the Install button to finish the installation.

The Start menu in your Windows will show a new program group for the NiceLabel
software that contains shortcuts for all NiceLabel applications.

To activate NiceLabel PowerForms Desktop as client to NiceLabel Control Center, see
the chapter Activate NiceLabel PowerForms Desktop Workstations.

Installing Scripting Support (optional)

NiceLabel label and form design software includes scripting support. Enhance the
possibilities of the software and add features not originally available in the software when you
use scripting. Scripting allows you to easily add conditional execution of actions,
comparisons, decision making (IF sentences) and more powerful calculations.

If you wish to use scripting in the solutions that you prepare for printing with NiceLabel
PowerForms Web, you must install Python support on the design workstation to be able to
write Python scripts.

To add Python support in NiceForm, do the following:

Note: Python is available in form designer NiceForm only. It is not available in the label

designer NiceLabel Pro. Keep this in mind, and move the scripts to the forms.
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1. To ensure a complete installation, close all open applications before installing the
software.

2. Insert the NiceLabel Control Center DVD in your DVD-ROM drive. An installation
window will open automatically. Close it.

Open Windows Explorer and browse to folder \Utility\Python on DVD-ROM.
4. Double-click file python-2.7.msi and follow on-screen prompts to install Python.

Double-click file pywin32-216.win32-py2.7.exe and follow on-screen prompt to
install Python extensions from Microsoft Windows.

6. When designing forms with scripting in NiceForm, select File -> Form Properties ->
Scripting, then select Python as the default scripting language. This setting applies to
all Execute script actions in this form. You will have to adjust Scripting options for
each form in which you will use Python scripts.

Note: You might be familiar with NiceLabel support for VBScript. It is available
automatically after the NiceLabel PowerForms Desktop installs. However, VBScript
can only be used in desktop applications, and is not available for printing on the Web in
NiceLabel PowerForms Web.

3.5 Installing NiceLabel Printer Driver

You can use the NiceLabel software to design and print labels to standard office printers
(laser, inkjet or matrix) or to professional label printers (thermal printers). If you own a
thermal printer, you must install the appropriate printer driver before you can print labels.
You will find NiceLabel Printer Drivers for all major thermal printer brands on the NiceLabel
DVD and on the NiceLabel Web site.

You can install NiceLabel Printer Driver for your thermal printer in the following ways:

e [nstall within the NiceLabel software installation.
e Use the Printer Installation Wizard on the NiceLabel Installation CD.
e Use the Windows Add Printer Wizard.

NiceLabel Printer Driver installation within NiceLabel software
installation

To continue installing the NiceLabel Printer Driver after the NiceLabel software installation
has finished, do the following:

1. Select the option Run Printer Installation Wizard in the last step of NiceLabel
PowerForms Desktop installation.

Click the Finish button.
The Printer Installation Wizard will open.
Select your printer from the list. Click the Next button.

o~ w D

Select the port where you have connected your printer and click the Finish button.
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Note: This type of printer installation is available only when running installation from
NiceLabel DVD.

NiceLabel Printer Driver Installation using the Printer Installation
Wizard

1. Insert the NiceLabel DVD in your optical drive. The main installation application
should start automatically. If not, start Windows Explorer, browse to the CD, and
double click the START.EXE file.

2. Click on Install NiceLabel Printer Drivers. The printer installation wizard will start.

r -
@ NicelLabel Control Center | = ‘ Iﬁl
NiceLab |7| @ Install NiceLabel product

|ceLane
@ Install NiceLabel Printer Drivers
® Explore DVD

NicelLahel
CONTROL CENTER

www.nicelabel.com

A

Figure 3: Starting printer driver installation from CD

3. Select your printer from the list. Click on the Next button.

10
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-

Selecting the printer

Select Printer
Pleaze zelect the manufacturer and prinker you want ta install.

Select the manufacturer and model of paur printer. If the driver iz in a different folder or your
printer came with a driver diskette, click <Change location:. |F pour printer iz not listed, consult
wour printer documentation for a compatible printer.

Manufacturers: Brinters:

Allen - Avery 511 -
Altec Awven 636

A-POS Awery £4-04

ARGOX Avery B4-04 RFID

ATD Avery B4-05

BEIAMG/SHEC Avery B4-06

Bl<0LOM Avwery B4-08 RFID

Blazepoint 5 Aweny 54-03 5

’ LChange location. .. ]

Exit H Help ] < Previous

e

Figure 4: Selecting the thermal printer

4. Select the port where you have connected your printer, and click on the Finish button.

Note: If you have downloaded the installation from the NiceLabel Web site, run the

downloaded .EXE file and follow the steps three (3) to four (4).

NiceLabel Printer Driver installation using the Windows Add Printer
Wizard

1.
2.
3.

Open the Start menu, go to Settings, and open the Control Panel.
Open Printers (Printers and Faxes) and select Add a Printer.

Follow the Add Printer Wizard prompts. The actual steps vary depending on the
version of your Windows operating system. It is only important to click the Have disk
button in the step where you can select printer manufacturer and model.

Put the NiceLabel DVD in your optical drive (if not already done so) and browse to the
folder \Drivers.

Select the folder of your printer name and click the Open/OK buttons to return to the

Add Printer Wizard. You will see the list of all available printer models of the selected
printer.

Select your model, click the Next button and finish the installation.

11
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3.5.1 Label Services

A Windows service application called Label Services is installed and started on each client
after the NiceLabel application installation. Label Services monitors the local printer and its
print job status which results in the local job log. Printer and job statuses are also sent to the
NiceLabel Enterprise Print Manager where the central print job log is updated. The central
print job log contains accurate information about the printed jobs and printer statuses.

Note: Label Services needs to run so that the NiceLabel client can report print jobs to
NiceLabel Enterprise Print Manager (EPM).

You can control this service manually by using the Service Manager. Label Services supports
the following functionalities that are not available if the service is stopped:

e Advanced Printing - feedback from the Windows print spooler about print job
progress is written to a NiceLabel log file.

e Communication between the NiceLabel client and Enterprise Print Manager is
active (sending print job/event information from client to EPM).

¢ NicePrintQueue can be used.

If any of the mentioned functions are not available, you can check the Label Services status
on the NiceLabel workstation. Open Administrative Tools in the Control panel and double-
click the Services icon. To start the service, right-click on the Label Services service in the
right-pane and select Start. Its status will change to Started.

F =

. Services =R X
File Action View Help
N w e I
& Services (Local) . Services (Local)
Label Services Name Description Status Startup Type Log On As m
) i IP Helper Provides tu...  Started Automatic Local Syste..
Stop the SEMVICE “.IPsec Policy Agent  Internet Pro.. Started Manual Network 5...
Pause the service . o )
Restart the service o KtmRm for Distrib... Coordinates.., Manual MNetwork 5...
4 Label Services Communic.. 5ta B al Syste...
Descriti o Link-Layer Topeolo.. Creates a M... start cal Service
escription: . R . Stop
Comrmunicates with thermal printer % Ma-Service al Syste...
drivers and queries information of . Media Center Exte... Allows Med... Pause cal Service
printer and job status. If this service is 0, Microsoft MET Fr... Microsoft ... Resume cal Syste..
stopped, the printer status % Microsoft NET Fr.. Microsoft ... Restart cal Syste...
information cannot be stored inte the . )
local label-print lag file or to the & Microsoft NET Fr...  Microsoft ... cal Syste...
Enterprise Print Manager. " Microsoft .MET Fr... Microsoft .... All Tasks cal Syste...
& Microsoft Antimal... Helps prote.. Star Refresh cal Syste...
i Microsoft iSCSI Ini.. ManagesIn... cal Syste..
o Microsoft Metwor...  Helps guard...  Star Properties cal Service
", Extended { Standard / Help
Stop service Label Services on Lecal Computer

Figure 5: Starting Label Services service

Note: Label Services service is using the TCP/IP ports 6758 and 6759 to communicate with
NiceLabel EPM and NicePrintQueue modules. You need to ensure that any firewall
applications allow this communication, so NiceLabel client can report print jobs to
NicePrintQueue and NiceLabel EPM.

12
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3.6 Activating NiceLabel Control Center

You can activate NiceLabel Control Center server by adding the NiceLabel Control Center
license into NiceLabel EPM. Before you start the activation process, get familiar with the
following terminology:

e Key number: The sequence of 25 characters provided with the NiceLabel
software.

e Registration number: Unique number generated during the activation process. The
registration number validates the entered software key.

e Activation code: Issued on the Activation Web site. The activation code activates
the NiceLabel software on your computer.

3.6.1 Activate NiceLabel Control Center server

To activate the NiceLabel Control Center server, do the following:

1.

Open the EPM (http://server/EPM) and select the Administration tab, then click
Activation in the menu on the left.

Click the Activate new product button.

On the Activation - User Information page, enter the required customer information
and the Key Number that was delivered in the NiceLabel Control Center product
package.

Click the Next button. The Product Activation page opens and the Registration number
is generated automatically. If the computer has an Internet connection, you can
complete the activation by clicking the Automatic Activation button.

If the computer where you started the activation procedure does not have Internet access, do
the following:

5.
6.
7.

Write down the Key Number and the Registration Number.
Write down the publisher’s Activation Web page address.

Go to a computer with Internet access and enter the Activation Web page address in the
Internet Explorer.

Enter the Key Number and the Registration Number. Enter other user information when
prompted.

Click on the ACTIVATE button to retrieve the Activation Code. Write it down.

Note: The Key Number, Registration Number, Activation Code and information in
other fields are case-sensitive, so be careful when writing it down.

10. Go back to the computer where the EPM Product Activation page is still open.
11. Enter the Activation Code.
12. Click the Finish button to complete the activation process.

13
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3.6.2 Activate NiceLabel PowerForms Desktop
Workstations

You have to activate NiceLabel clients (NiceLabel PowerForms Desktop), before you can
use it. If you do not complete the activation process, NiceLabel client will run in trial and then
in demo mode and will be limited in functionality.

The Product Activation Wizard will always run after client installation. If you want to change
the activation type, you can also start activation from the NiceLabel software by opening the
Manage License window under the Help menu.

To activate the NiceLabel software, do the following:

1. After you have installed the NiceLabel EPM server and NiceLabel PowerForms
Desktop products, and activated NiceLabel Control Center license, run the NiceLabel
software from your client computer. The Trial or Demo mode dialog box will display.
Select Enter license key.

Manage license I,&J

Welcome to Product Activation Wizard
This wizard will guide you through the produd activation process.

Product has not yet been activated or no valid licenses could be found. Please follow this
Activation Wizard to activate your copy of product or troubleshoot your active license.

Please choose product activation method:

Hardware Key
Single User Software Key
Pulti-user Software Key

@ Enterprise Print Manager license server

Figure 6: Manage License — Enterprise Print Manager license server

Cancel

L

2. Enter the computer name where Enterprise Print Manager is installed, and click Next.

14
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r© N
Manage license I&

Enterprize Print Manager license server
Select Enterprise Print Manager server name.

Please enter the name of the server where Enterprise Print Manager is installed,

Enterprise Print Manager server name

SEMver

I=n
3
T

Cancel ‘ I < Back H Mext =

L

Figure 7: NiceLabel Enterprise Print Manager server name

Note: If you have not activated the NiceLabel Control Center server, a warning will be
shown notifying you the licensing server is not activated yet. You can start the
server activation by clicking Yes. Follow the activation steps described in the
Activate NiceLabel Control Center topic.

NiceLabel client software will connect to the Enterprise Print Manager server and
retrieve the needed license. Additionally, detailed printing control setting will be

enabled and print job and printing events information will be logged on the EPM

server.

15
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r© N
Enterprize Print Manager license server ﬁ

WARMING: Changes in program configuration

??ﬁ Activation Wizard has successfully connected to the
license server. This results in following program
configuration changes:

Print job information will be logged on the server
Printing events will be logged on the server
Detailed printing control will be enabled

You can use the Options menu or the produc configuration tool
to change these settings.

e

Figure 8: NiceLabel configuration changes

4. You can verify the activation by clicking the Open License Information button.
Enterprise Print Manager Licensing page opens and displays the license type used for
activating this NiceLabel client.

r B
Manage license &J

Licenze information
EPM license server information

EPM license server information:

Mame WValue
Product: MicelLabel
License Level: Control Center
License Type: Micelabel Control Center license
Key Mumber: - =
Wersion: B.x
Open License Manager Open License Information

If you would like to see or manage current license or add new license, the wizard will assist
you with the license manage process.

9

Figure 9: NiceLabel Enterprise license

5. Click Finish to complete the activation of the NiceLabel client.

16
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Using License Manager

The License Manager module is used to monitor and manage licenses on the NiceLabel
PowerForms Desktop and NiceLabel Automation computers. License Manager displays the
information of the current client and also provides an overview of the total license occupation.
In an enterprise environment the NiceLabel PowerForms Desktop and NiceLabel Automation
Enterprise licenses are stored centrally on the Enterprise Print Manager (EPM) server.

You can also use the License Manager to enable/disable off-line mode for workstations. Off-
line mode enables selected workstations to function even if EPM server is not available or not
accessible. License Manager is used in environments where mobile label printing is required
or in events where server system failure would otherwise stop the label production.

To manage license modes, go to Help, Manage License, Open License Manager in
NiceLabel PowerForms Desktop or NiceLabel Automation application.

Force Off-line Mode: If this checkbox is selected, the License Manager will not check for
the presence of the EPM and the application will automatically start in the off-line mode.
When the license lease expires, the application will stop running and you must renew the
license by switching off this option and re-connecting to the EPM.

Note: The off-line license expires after 15 days.

17
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4. NiceLabel Control Center
Configuration

4.1 Configure NiceLabel Client Settings

NiceLabel settings on a standalone client are changed and stored locally on each workstation.
In an enterprise environment however, there might be a need to change all relevant settings
centrally. NiceLabel Control Center server settings together with NiceLabel client settings can
be managed on the server.

To open the Enterprise Print Manager Configuration utility, click Start — All Programs —
NiceLabel Enterprise Manager — Utilities — EPM Configuration.

Note: You need to use an account with administrative privileges to be able to change all
settings in the NiceLabel Configuration dialog.

Click Monitor Events setting under the Enterprise Print Manager heading in the left column.
Here you can select which event types, occurring on the local machine are logged to the
Enterprise Print Manager database. Print Events, Error Events and NiceLabel Automation
Activity are logged by default.

[ Options I,ih,l1

General Event Monitoring
Errar configuration
) You can select what type of events system should log to the
Log file 5 :
Enterprise Print Manager
Folders
Language
Label usage passwords | Print Events

User rights and access

| Errar Events
Enterprise Print Manager

Monitor events Warning Events
Manitar print jobs Information Events
Settings _ o
MiceLabel Pro | MiceWatch Activity
Desktop MiceWatch Status Change Events
Calors
Settings
Printers

Show all settings

K ] | Cancel Apply Help

L

Figure 10: Configuring events to be monitored

In the Monitor Print Jobs section you can decide whether local print jobs are reported to the
Enterprise Print Manager (EPM) print job log or not. When the client machine gets a license
from an EPM server, the print job logging to server will be enabled.

18
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[ Options [ﬁr

General Print Job Manitoring
Error configuration -
) /g Youcan choose to log Print Jobs to the Enterprise Print Manager
Log file =
Folders
Language

| Enable Print Job Logging to Server
Label usage passwaords

User rights and access
Enterprise Print Manager
Monitor events
Monitor print jobs
Settings
MiceLabel Pro
Desktop
Colors
Settings
Printers

Show all settings

oK l | Cancel Apply Help

L

Figure 11: Configuring print job monitoring

4.1.1 Configuration Settings location

All Configuration settings are stored locally on each NiceLabel workstation by default. As
alternative, you can store the NiceLabel settings centrally on the Enterprise Print Manager
(EPM) server.

If you want your settings to be stored locally, select the Local radio button in the Settings
location section.

Your settings can be shared by other NiceLabel workstations in the network. For this purpose,
you can upload your optimized settings to the EPM server by clicking the Store to Server
button. To download your workstation settings to another machine, click the Retrieve from
Server button on that machine. Depending from where you opened the Configuration dialog
the new settings will be effective when you click the OK button or at the next NiceLabel
application start.

If your company policy requires a strict settings enforcement policy (for example, all
NiceLabel workstations should use the same language), you can enable it by selecting Global
(Automatic synchronization). In this case, every time you (or your users) start NiceLabel
software, it will synchronize the most current settings with the EPM server.
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Figure 12: Enterprise Print Manager Settings

Note: Most settings here can only be viewed, but not changed if the current user does not
have administrator privileges.

4.2 Configure Document Storage on Client

NiceLabel EPM offers the Document Storage functionality, which is a shared repository
which is accessed over WebDAYV by users from anywhere in the world. To change the
Document Storage Server, use the Settings dialog in the NiceLabel Configuration dialog.

To open the NiceLabel Settings dialog, do the following:

1. Go to Start, All Programs, NiceLabel Enterprise Manager, Utilities,
Configuration to open the NiceLabel Configuration dialog box.

2. Select the Settings in the Enterprise Print Manager group.

The default connection port and server name are displayed. Adjust these settings and your
Document Storage Server is ready for use.

To change the default Document Storage settings on the EPM server, see Knowledge Base
article KB188.
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Figure 13: Settings to connect to Storage Server

4.3 Configure Authentication

If security standards of your company require higher level of security to protect access to
Nicelabel Enterprise Print Manager (EPM) functionality, you can use the NiceLabel
authentication feature.

Note: It is possible to customize limited EPM access rights for users. A user’s access can be
limited to only certain subsections in the EPM, while the others remain unaccessible
and hidden from him. For more information, see the labeling software User Guide.

To enable the NiceLabel authentication feature, do the following:

1. Go to Start — All Programs — NiceLabel Enterprise Manager — Utilities —
EPM Configuration to open the Enterprise Print Manager Configuration utility.

2. Select the User rights and access page in the Enterprise Print Manager group of

settings.

Click the Authentication Mode button to open the Authentication mode dialog.

4. Select one of the possible authentication modes:

¢ Windows authentication, using Windows authentication system

¢ Application authentication, using NiceLabel users, groups and profiles (for
more information, see NiceLabel Pro User Guide).

e Mixed, not available for logging into NiceLabel EPM.

21



NiceLabel Control Center User Guide

-

Authentication Mode @Iéj

Authentication Mode

@ Mone
) Windows authentication
) Application authentication

) Mixed (Windows and Application authentication)

Enterprise Print Manager (EPM]} cannot use mixed

authentication. If mixed mode is chosen, EPM will fall back to
Windows authentication,

Ok ] l Cancel

L

Figure 14: NiceLabel Authentication mode

Note: Changed settings need to be saved in the EPM configuration database.
For more information, see the Configuration Settings location topic.

4.3.1 Login into EPM

After the correct authentication mode has been confirmed and replicated, the login dialog box
is shown every time the Enterprise Print Manager Home page is accessed. You need to
provide a correct User Name and Password to gain access to NiceLabel EPM functionality.
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5. Using NicelLabel Enterprise Print
Manager

Refer to the document NiceLabel Enterprise Print Manager User Guide.
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6. Technical Support

If you experience any technical difficulties using the NiceLabel software, the first thing to do
is to refer to the built-in help, User guides available on the NiceLabel DVD and online
Knowledge Base.

You can find the latest builds, updates, workaround for problems and Knowledge Base under
the Support section on the product Web site at www.nicelabel.com. If you cannot solve the
problem on your own, please contact your local vendor or representative offices.

For more information, see:

Knowledge Base: http://kb.nicelabel.com

NiceLabel user guides: http://www.nicelabel.com/Learning-center/User-Guides

NiceLabel Tutorials: http://www.nicelabel.com/Learning-center/Tutorials

NiceLabel Forums: http://forums.nicelabel.com/
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